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Overview

RP2350-ETH-8DI-8RO

Introduction

RP2350-ETH-8DI-8RO is an industrial-grade 8-channel
network relay based on RP2350B microcontroller and
supports RS485, Ethernet port and other peripheral
interfaces. It features built-in power isolation and
optocoupler isolation and other protection circuits, which

is safe, stable and more reliable.

Features (https://www.waveshare.com/RP2350-

= RP2350B microcontroller chip officially designed by ETH-8DI-8RO.htm)

Raspberry Pi

= Unique dual-core and dual-architecture design,
equipped with dual-core ARM Cortex-M33 processor and dual-core Hazard3 RISC-V
processor, flexible clock running up to 150 MHz, supporting flexible switching between the
two architectures

= Built-in 520KB of SRAM and 16MB of on-chip Flash

= Type-C port, easier to use

= High quality relay, contact rating: <10A 250V AC or <10A 30V DC

= The digital inputs feature bidirectional optocoupler isolation, supporting both passive and
active switch inputs. The relay outputs can be controlled via a switch interlock (linkage) mode

= Onboard isolated RS485 interface, for connecting to various RS485 Modbus industrial
modules or sensors

= Onboard pin header, allowing access to other devices

= Onboard power supply screw terminal, supports 7~36V wide voltage input, suitable for
industrial applications

= Onboard RTC clock chip, supports timing tasks

= Onboard W5500 Ethernet chip, extending 10/100Mbps network connectivity via SPI interface

= PoE network port version supports external PoE module for Power over Ethernet (IEEE 802.3af
compliant)

= Onboard optocoupler isolation to prevent interference with control chip from external high-
voltage circuit connected to the relay

= Onboard digital isolation to avoid external signal interference with the control chip

= Onboard integrated power isolation, providing stable isolation voltage, no extra power supply
required for the isolated terminal

= Onboard TF card slot, supporting external TF card storage for pictures or files

SP1 /12C / RS485
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= Built-in buzzer, RGB colorful LED, power supply and RS485 TX/RX indicators for monitoring
the operating status of the module
= Rail-mounted ABS protective enclosure, easy to install, safe to use
» USB1.1 host and slave device support
= Low-power sleep and dormant modes
» Drag-and-drop programming via USB mass storage
= 15 x multi-functional GPIO pins
m 2 x SPI, 2 x 12C, 2 x UART, 8 x 12-bit ADC and 12 x controllable PWM channels
m Accurate clock and timer on-chip
= Temperature sensor
= On-chip accelerated floating-point library
= 12 x Programmable 1/O (PIO) state machines for custom peripheral support
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I Dimensions
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Electrical and Relay Safety Instructions

= This product must be operated by professional electricians or qualified personnel. During use,
ensure electrical safety, leakage protection, and proper insulation.

» Before installing, maintaining, or replacing the relay device, always turn off the power and
unplug the device.

= Do not attempt to disassemble the relay device to avoid damage or the risk of electric shock.

» Properly install and place the relay device. Do not use it in humid, overheated, flammable, or
explosive environments to prevent accidents caused by improper installation or use.

1. Load Matching

= Ensure the relay's rated voltage and current match the load. Do not exceed the rated capacity.

https://www.waveshare.com/wiki/RP2350-ETH-8DI-8RO 4/37
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= Forinductive loads (motors, coils, lamps, etc.), the starting current may be much higher than
the rated current. Choose a relay with sufficient current margin.

2. Short Circuit and Overcurrent Protection

= [nstall a fuse or circuit breaker in the relay circuit to prevent damage due to short circuits or
accidental overcurrent.

= Ensure the load circuit has no short circuits during wiring, and select protection components
with appropriate current ratings if necessary.

3. Arc and Switching Protection

= Relay switching generates arcs, which can cause contact wear or welding.
= For inductive loads, it is recommended to use RC snubber circuits or varistors for arc
suppression.

4. Installation Environment

= Do not use the relay in humid, high-temperature, flammable, explosive, or dusty
environments.

= |nstall the relay securely to avoid vibrations or shocks that may cause misoperation or
damage.

5. Power-Off Operation

= Always cut off power before maintenance, wiring, or replacing the relay to ensure personnel
and device safety.

= Latching relays are only powered when changing state. Avoid strong vibrations or strong
magnetic fields while the relay is unpowered.

6. Status Confirmation

= After powering on, confirm or reset the relay status as needed to prevent abnormal operation
caused by transportation, installation, or external disturbances.

= Avoid power interruption during relay operation to prevent uncertain status or contact
damage.

7. Regular Inspection

= Periodically inspect relay contacts, terminals, and insulation to ensure proper operation.
= |f abnormal heating, odor, or burn marks are detected, immediately cut off power and replace
the relay.

Pico Getting Started

Firmware Download

= MicroPython Firmware Download [Expand]

https://www.waveshare.com/wiki/RP2350-ETH-8DI-8RO 5/37



10.05.26, 18:59 RP2350-ETH-8DI-8RO - Waveshare Wiki

= C Blink Firmware Download [Expand]

Basic Introduction

Raspberry Pi Pico Basics (https://www.waveshare.com/wiki/Pico_Basic_Introduction)

MicroPython Series

Install Thonny IDE

To facilitate the development of Pico/Pico2 boards with MicroPython on a computer, it is

recommended to download the Thonny IDE

= Download Thonny IDE and follow the steps to install, the installation packages are all
Windows versions, please refer to Thonny's official website for other versions
= Thonny IDE official download link (https://github.com/thonny/thonny/releases/downloa
d/v3.3.3/thonny-3.3.3.exe)
= Thonny IDE download link (https://files.waveshare.com/wiki/common/Thonny-3.3.3.zip)
= Thonny official website (https://thonny.org/)
» After installation, configure the language and motherboard environment for the first use.

Since we are using Pico/Pico2, pay attention to selecting the Raspberry Pi option for the
motherboard environment

=]
X

Th Thonny - <untiied= @ 111

| File Edit View PBun Tools Help

Ty OB o

Shell

2>

Pethon 3.7.9

(/Wiki/FiIe:Pico-R3-T6nny1 png)

= Configure MicroPython environment and choose Pico/Pico2 port
= Connect Pico/Pico2 to your computer first, and in the lower right corner of Thonny left-
click on the configuration environment option --> select Configure interpreter
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= In the pop-up window, select MicroPython (Raspberry Pi Pico), and choose the
corresponding port
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T& Thonny options x

General | Interpreter | Editor | Theme & Font | Run & Debug | Terminal | Shell | Assistant
Which interpreter or device should Thonny use for running your code?
MicroPython (Raspberry Pi Pico) -
Dretails

Connect your device to the computer and select corresponding port below
(look for your device name, "USB Serial” or "UART").
If you can't find it, you may need to install proper USB driver first.

Part
USB S{FEE (COMT) v

Install or update firmware

(/wiki/File:Raspberry-Pi-Pico-Basic-Kit-M-3.png)
Flash Firmware

= Click OK to return to the Thonny main interface, download the corresponding firmware
library and flash it to the device, and then click the Stop button to display the current
environment in the Shell window
= Note: Flashing the Pico2 firmware provided by MicroPython may cause the device to be
unrecognized, please use the firmware below or in the package
» Pico firmware library (https://files.waveshare.com/wiki/Raspberry-Pi-Pico-2/RPI_PICO-20
250415-v1.25.0.zip)
= Pico2 firmware library (https://files.waveshare.com/wiki/common/WAVESHARE-RP2350-
20250711-v1.26.0.zip)
= Pico2 16MB firmware library (https://files.waveshare.com/wiki/common/WAVESHARE-RP
2350-20250807-v1.26.0-16MB.zip)
= RP2350B firmware library (https://files.waveshare.com/wiki/common/WAVESHARE _RP23
50B.zip)
= How to download the firmware library for Pico/Pico2 in windows: After holding down the
BOOT button and connecting to the computer, release the BOOT button, a removable disk will
appear on the computer, copy the firmware library into it

= How to download the firmware library for RP2040/RP2350 in windows: After connecting to
the computer, press the BOOT key and the RESET key at the same time, release the RESET key
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first and then release the BOOT key, a removable disk will appear on the computer, copy the
firmware library into it (you can also use the Pico/Pico2 method)

v

T

g (m)

Shell
333 /

>3

PicroPython (Raspbery Pi Pico)

(/wiki/File:Raspberry-Pi-Pico2-Python.png)
MicroPython Series Tutorials

[MicroPython] machine.Pin class function details (https://www.waveshare.com/wiki/%E3%8
0%90MicroPython%E3%80%91 _Machine.Pin_Functions)

[MicroPython] machine.PWM class function details (https://www.waveshare.com/wiki/%E3%
80%90MicroPython%E3%80%91machine.PWM_Function)

[MicroPython] machine.ADC class function details (https://www.waveshare.com/wiki/%E3%8
0%90MicroPython%E3%80%91machine.ADC_Function)

[MicroPython] machine.UART class function details (https://www.waveshare.com/wiki/%E3%
80%90MicroPython%E3%80%91machine.UART_Function)

[MicroPython] machine.l2C class function details (https://www.waveshare.com/wiki/%E3%8
0%90MicroPython%E3%80%91machine.l2C_Function)

[MicroPython] machine.SPI class function details (https://www.waveshare.com/wiki/%E3%8
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0%90MicroPython%E3%80%91machine.SPI_Function)
[MicroPython] rp2.StateMachine class function details (https://www.waveshare.com/wiki/%E
3%80%90MicroPython%E3%80%91PIO_Function)

C/C++ Series

For C/C++, it is recommended to use Pico VSCode for development. This is a Microsoft Visual

Studio Code extension designed to make it easier for you to create, develop, and debug

projects for the Raspberry Pi Pico series development boards. No matter if you are a beginner

or an experienced professional, this tool can assist you in developing Pico with confidence and

ease. Here's how to install and use the extension.

= Official website tutorial: https://www.raspberrypi.com/news/pico-vscode-extension/
(https://www.raspberrypi.com/news/pico-vscode-extension/)

= This tutorial is suitable for Raspberry Pi Pico, Pico2 and the RP2040 and RP2350 series
development boards developed by Waveshare

= The development environment defaults to Windows11. For other environments, please refer
to the official tutorial for installation

Install VSCode

1. First, click to download pico-vscode package (https://drive.google.com/file/d/18-KDNrQII0Ku
TMdS6W5iblUGaGm3FbVJ/view?usp=sharing), unzip and open the package, double-click to
install VSCode
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(/wiki/File:Pico-vscode-1.png)
Note: If vscode is installed, check if the version is v1.87.0 or later
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Visual Studho Code X

o Visual Studio Code

| version 1931 (user setup) |
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Copy | 0K

Install Extension

1. Click Extensions and select Install from VSIX
] File Edit Selection View Go Run Terminal Help

EXTEMSICIBS Yy fass
L || LRl LI 1_\_(' e

nsi in Y . ! W IEWAS
Check {or Extension Update
» INSTALLED
Lisable Auto Update for All Extensions
> POPULAR

» RECOMMENDED
Disable All Installed Extensions
Show Bunn ng Extensions

Start Extension Bisect

Install from VSI(.. 3

https://www.waveshare.com/wiki/RP2350-ETH-8DI-8RO 12/37



10.05.26, 18:59 RP2350-ETH-8DI-8RO - Waveshare Wiki
(/wiki/File:Pico-vscode-4.png)
2. Select the package with the vsix suffix and click Install

) install from VSIX ®
< T S » Des. » pica. @ s :':'_5 Search pico-wscode =
Organize = Mew folder = - o
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¥ Downloads #
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w= Local Disk (C #
File name; fraspberry-pi-pico-D.IE.E.vsm . | VSIX Extensions (*.vsix)

| Install

(/wiki/File:Pico-vscode-5.png)

3. Then vscode will automatically install raspberry-pi-pico and its dependency extensions, you

can click Refresh to check the installation progress
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4. The text in the right lower corner shows that the installation is complete. Close VSCode
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Configure Extension
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RP2350-ETH-8DI-8RO - Waveshare Wiki
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1. Open directory C:\Users\username and copy the entire .pico-sdk to that directory
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2. The copy is completed
- = o x
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3. Open vscode and configure the paths for the Raspberry Pi Pico extensions

= e T ng

o Extensions

Raspberry Pi Pico Extension

(/wiki/File:Pico-vscode-10.png)
The configuration is as follows:

.
'
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
'
1
1
1
1
1
1
]
]
]
]
]
]
]
]
]
]
'
]
]
]
]
]
]
]
]
]
]
]
]
'

Cmake Path:
${HOME}/.pico-sdk/cmake/v3.28.6/bin/cmake.exe

Git Path:
${HOME}/.pico-sdk/git/cmd/git.exe

Ninja Path:
${HOME}/.pico-sdk/ninja/v1.12.1/ninja.exe

Python3 Path:
${HOME}/.pico-sdk/python/3.12.1/python.exe

New Project

1. The configuration is complete, create a new project, enter the project name, select the path,
and click Create to create the project
To test the official example, you can click on the Example next to the project name to select

W - . oo .
]
(2] = e

x5 iy ST Ao )
Bani Satmnge

=
Firtui s
Shfin wippert

(/wiki/File:Pico-vscode-11.png)
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2. The project is created successfully

(/wiki/File:Pico-vscode-12.png)
Compile Project
1. Select the SDK version

(/iki/FiIe:Pico-vscode-1 3.png)
2. Select Yes for advanced configuration

Switch Tools

N

Yes

(/wiki/File:Pico-vscode-14.png)
3. Choose the toolchain, 13.2.Rel1 is applicable for ARM cores, RISCV.13.3 is applicable for RISCV
cores. You can select either based on your requirements
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(/wiki/File:Pico-vscode-15.png)
4. Select Default for CMake version (the path configured earlier)

Custom path
(/wiki/File:Pico-vscode-16.png)
5. Select Default for Ninja version

Default
Speaific verson
Custam path

Use system Minja

(/wiki/File:Pico-vscode-17.png)
6. Select the development board

= AR [efoRel

PATITL SWORRLRALT FireC L

(/ii/FiIe:Pico-vscode-1 8.pnQg)
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7. Click Compile to compile
Ca : -~ i i

[

-------

(/wii/FiIe:Pico-vscode—1 9.pnQ)
8. The .uf2 format file is successfully compiled

L

(/wiki/File:Pico-vscode-20.png)
Flash Firmware

Here are two methods for flashing firmware

1. Flash firmware using the pico-vscode plugin
Connect the development board to the computer, click Run to flash the firmware directly
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2. Flash the firmware manually

& A 0] 0 e (e e MmO e e R

___________________________________________________________________________________________________________________________________________

Press and hold the Boot button
Connect the development board to the computer

A w N P

Copy the .uf2 file to the USB drive, and the device will automatically restart, ind

. Then the computer will recognize the development board as a USB device. i
icating successful program flashing.

___________________________________________________________________________________________________________________________________________

Import Project

1. Select the project directory and import the project

- — i
W s
v o Raspberry Pi [Fico] St
Basiz Sevtieagi
Viarring Peosert beqart Woaid may sob wirk foe af pioects, sad will ofMen g
il CoiPECHOn @t the g
A = ]
Cabuzge
g
Show Aduarces Cptass Cawad | | impart ﬂ

(/wiki/File:Pico-vscode-23.jpg)

2. The Cmake file of the imported project cannot have Chinese (including comments), otherwise
the import may fail

3. To import your own project, you need to add a line of code to the Cmake file to switch
between pico and pico2 normally, otherwise even if pico2 is selected, the compiled firmware
will still be suitable for pico
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Update Extension
1. The extension version in the offline package is 0.15.2, and you can also choose to update to

the latest version after the installation is complete
" e il P ==p— [ f=F

* " Raspberry Pi Pico Visual Studio Code extension
=l

Foner The armenikon B omeTTy unds devHag e

......

.........

(/i/FiIe:Pico-vscode-ZZ.png)
Arduino IDE Series

Install Arduino IDE

1. First, go to Arduino official website (https://www.arduino.cc/) to download the installation
package of the Arduino IDE.
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HARDWARE SOFTWARE cLoup DOCUMENTATION = COMMUNITY = BLOG ABOUY

Arduino Web Editor

Saart cadietg onling and save your skesches in the cloud, The maost
Lp-T0-dare Yerssan of the IDE includes all ibrares and also
SUPPOITS new Ardutro boards

Downloads

DOWNLDAD DFTTOMS

oo} Arduino IDE 2.0.0

Windows »
Windows 2

The new major ralease of the Arduing IDE is faster and even more
powerfull in addition to a more modern editor and a more Linux Appimag

responsive interface it features autocompletion, code navigation, Linux Zif file 64 b

and even alive UEDUEEE r macO5 14 o™ or riwer, 64 bits

For more details, please refer to the Arduino IDE 2.0
documentation.

Mightly bullds with the latest bugfixes are avallable through the
section below.

SOURCE CODE

The Arduing IDE 2.0 is open source and its source code is hosted on
GitHub.

(/wiki/File:Arduino%E4%B8%8B%E8%BD%BD2.0%E7%89%88%E6%9C%AC.jpg)
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2. Here, you can select Just Download.

Support the Arduino IDE

Since the release 1.% release in March 2015, the Arduino IDE has
been downloaded 69,954,557 times — impressive! Help its
development with a donation.

$3 $5 $10 $25 $50 Other

JUST DOWNLOAD CONTRIBUTE & DOWNLOAD

e
60

Learn more about donating to Arduino.

(/wiki/File:%E4%BB%85%E4%B8%8B%E8%BD%BD%E4%B8%8D%E6%8D%90%E8%B5%A0.png)

3. Once the download is complete, click Install.
E8 Arduino Setup; License Agreement

=

I, Please review the license agreement before installing Arduine, If you
.2 accept all terms of the agreement, dick I Agree.

GMU LESSER. GEMERAL PUBLIC LICEMSE ~
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <htto:/f=forg>

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms
and conditions of version 3 of the GNU General Public License, supplemented
by the additional permissions listed below.

¥

Cancel MullsoFt Tnstal System »53.0 I Agree

(/wiki/File:IDE%ES5%AE%89%E8%A3%85%E6%B0%B4%E5%8D%B0-1.gif)

Notice: During the installation process, it will prompt you to install the driver, just click
Install

Arduino IDE Interface
1. After the first installation, when you open the Arduino IDE, it will be in English. You can switch
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to other languages in File --> Preferences, or continue using the English interface.

File Edit Sketch Tools Help

PMew Ctrl+M

Open.. Cer+0

Sketchbook L

Examples | 3

Close Crl + 10 L

s — (/wiki/File:%E9%A6%96%E9%80%89%E9%A1%B9-
Save As.. Ctrl+Shift+5

Preferences.. Ctrl+iE=

Advanced L4

Chuit Ctrl+Q

%E7%AE%80%E4%BD%93%E4%B8%AD%E6%96%87.jpg)
2. In the Language field, select the language you want to switch to, and click OK.

Preferances

OCazho
xutong Documents A dulne BROWSE

©>

(/wiki/File:%E9%A6%96%E9%80%89%E9%A1%B9-
Y%E7%AE%80%E4%BD %93%E4%B8%AD%E6%96%870k jpg)

Install Arduino-Pico Core in Arduino IDE

1. Open the Arduino IDE, click on the file in the top left corner, and select Preferences
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File Edit Sketch Tools Help

Mew Ctrl+MN

Open.. Cirl+ 0

Sketchbook v

Examples 3

Close Crl £ o . .
s R (/wiki/File:RoArm-M1_Tutorial04.jpg)
Save As.. Cerl+Shift+5

Freferences,.. Ctrl+iE=

Advanced b

Quit Ctrl+Q

2. Add the following link to the attached board manager URL, and then click OK
This link already includes board versions such as RP2040 and RP2350. Please visit
arduino-pico (https://github.com/earlephilhower/arduino-pico) for the latest version
files

___________________________________________________________________________________________________________________________________________

https://github.com/earlephilhower/arduino-pico/releases/download/4.5.2/package_rp2040_
index.json

m
£

-
A el bt o UL NS N exrasall Convalissckans. 6ipia. ki o

(/wiki/File:RoArm-M1 _Tutorial_1105.jpg)
Note: If you already have an ESP32 board URL, you can use a comma to separate the

URLs as follows:

https://dl.espressif.com/dl/package_esp32_index.json,https://github.com/earlephilhowe
r/arduino-pico/releases/download/4.5.2/package_rp2040_index.json

3. Click Tools > Development Board > Board Manager > Search pico, as my computer has
already been installed, it shows that it is installed
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T

e 5

>3y

MicroPyman [Rasgberry P Fios)

(/wiki/File:Pico_Get_Start 05.png)
BOARDS MAMAGER

pico
E Type: All v

Arduino Mbed OS RF2040
Boards by Arduino

Boards included in this package: Raspberry

Pi Pico
More info
404 ~ (/wiki/File:Pico_Get_Start_06.png)

Raspberry Pi Pico/RP2040 by
Earie F. Philhower, 1l

Boards included in this package: Raspberry
Pi Pico, Raspberry Pi Pico W, 0xCB Helios,
Adafruit Feather RP2040, Adafruit Feather...
More info

264 ~ INSTALL

Upload Demo at the First Time
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1. Press and hold the BOOTSET button on the Pico board, connect the pico to the USB port of
the computer via the Micro USB cable, and release the button after the computer recognizes
a removable hard disk (RPI-RP2).

(/wiki/File:Pico%E8%BF%9E%E6%8E%A5%E6%95%B0%E6%8D%AE%ET7%BA%BF.gif)

2. Download the program and open D1-LED.ino under the arduino\PWM\D1-LED path

3. Click Tools --> Port, remember the existing COM, do not click this COM (the COM displayed
is different on different computers, remember the COM on your own computer)
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@ OLED_1inS | Arduinc IDE 2.0.3

ZiF) W@ OB

OLED_1in5
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W 00~ v 1 b w M

=
o

1l
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14
15

(/wiki/File:Pico%E8%BF%9E%E6%8E%A5%ES5%89%8D%E7 %AB%AF%ES5%8F%A3.png)
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4. Connect the driver board to the computer using a USB cable. Then, go to Tools > Port. For the

first connection, select uf2 Board. After uploading, when you connect again, an additional

COM port will appear
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5. Click Tools > Development Board > Raspberry Pi Pico > Corresponding models (Raspberry Pi

Pico, Raspberry Pi Pico 2, etc.)
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v Raspberry Pi Pico

(/wiki/File:Arduono-Raspberrypi_pico.png)
6. After setting it up, click the right arrow to upload the program
@& OLED_1in5 | Arduino IDE 2.0.3

TiHF) #E WE I8 =5

(/wiki/File:Pico%E4%B8%8A%E4%BC%A0%E7 %A8%8B%ES5%BA%8F.png)

= |f issues arise during this period, and if you need to reinstall or update the Arduino IDE
version, it is necessary to uninstall the Arduino IDE completely. After uninstalling the
software, you need to manually delete all contents within the C:\Users\
[name]\AppData\Local\Arduino15 folder (you need to show hidden files to see this
folder). Then, proceed with a fresh installation.

Open Source Demos

MircoPython video demo (github) (https://github.com/waveshareteam/Pico_MircoPython Exa
mples)

MicroPython firmware/Blink demos (C) (https://files.waveshare.com/wiki/common/Raspberry
Pi_Pico Demo.zip)

Raspberry Pi official C/C++ demo (github) (https://github.com/raspberrypi/pico-examples/)
Raspberry Pi official MicroPython demo (github) (https://github.com/raspberrypi/pico-microp
ython-examples)

Arduino official C/C++ demo (github) (https://github.com/earlephilhower/arduino-pico)

Demo

C/C++ Demo

01 RS485
Demo description

» This example implements the control of 8 relay switches via RS485 and 8Dl digital inputs

Code analysis

= Relay Control(): This function mainly executes the corresponding relay control operation
and outputs the corresponding status prompt information according to the array index
passed through the parameters
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= Parameter analysis
® uint8_t index:In the main function, the program will parse the received RS485
data and match it with the preset control command array. When a match is
found, the Relay_control function is called, and the index position of the
matching command in the array is passed via index parameter
= Logical flow
= Use the if else statement to perform different operations based on the value
of index:
= |n the case of index < 8, that s, for the cHi~cH6é commands, the
DEV_Digital_Write function is used to switch the level status of the
corresponding GPIO pin (such as RELAY1_PIN, etc.), and at the same time,
the corresponding relay_status array element is updated to record the
change of the relay status, and the corresponding on or off prompt
information is output according to the final state of the relay. Finally, in the
main function, the Beep function is called to control the buzzer.
= For the case of index = 8, i.e, for the ALL_oN command, all GPIO pins
(corresponding to 8 channel relays) are set to high level (on state). Using
the memset function, all elements of the relay_status array are setto 1,
indicating that all relays are turned on. A message indicating that all relays
are turned on is then output. Finally, in the main function, the Beep
function is called to control the buzzer.
» For the case of index = 9, i.e, for the ALL_oFF command, all GPIO pins
(corresponding to 8 channel relays) will be set to low level (off state). Using
the memset function, all elements of the relay_status array will be set to 0,
indicating that all relays are off. A message indicating that all relays are off
will be output. Finally, in the main function, the Beep function will be called
to control the buzzer.
= |f the value of index does not match the above commands, the prompt
message of receiving non-command data will be output
= gpio_irq_handler(): The function controls relay switches through IO interrupts, with digital
interfaces DI1~DI8 corresponding to relays CH1~CH8. For example, when the digital
interface DI1 is low, the relay CH1 is on, and when the digital interface DI1 is high, the
corresponding relay CH1 is off

RS485 Control

= Jump to RS485 Control Tutorial (https://www.waveshare.com/wiki/ESP32-S3-POE-ETH-8DI-
8RO-RS485)

02 MQTT

Demo description
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= This example implements network connection through an Ethernet interface and achieves
remote control of 8 relays via the MQTT communication protocol

Precautions

= Devices need to be created in Waveshare Cloud
= MQTT related parameters in the program need to be modified

Code analysis

= Function description
= ConnectNetwork() : Connect to the network via Ethernet port
= MQTTClientInit() : Initialize MQTT
= MQTTConnect() : Connect to MQTT server
= MQTTSubscribe() : Subscribe to MQTT topic
®  MQTTPublish() : Publish MQTT message
» Parameter description
= MQTT parameters
= MQTT_CLIENT_ID: Client ID
®  MQTT_USERNAME : Username
m  MQTT_PASSWORD : Password
m  MQTT_SUBSCRIBE_TOPIC : Name of the subscribed topic
= MQTT_PUBLISH_TOPIC : Name of the published topic
= Network connection parameters
= g net_info.mac : MAC address
m g net_info.ip: IP address
m g net_info.sn: Subnet mask
m g net_info.gw: Gateway
m g net_info.dns : DNS server
= Logical flow
= Device Initialization: Initialize the SPI interface of MQTT and Ethernet ports, call
ConnectNetwork() , MQTTConnect() to connect to the network and MQTT server, and
call mQTTsubscribe() to subscribe to MQTT topics
= Control relay switch: Wait for MQTT messages in the main loop. When it is
determined that the received MQTT message g_mqtt_client.msg.payload is not
empty, parse the MQTT message and control the corresponding relay switch
= Send relay status: In order to determine whether the relay switch operation is
successful from the server, the development board will call mMQTTPublish() to send the
latest relay status to the server after controlling the relay switch

Waveshare Cloud Control

= Jump to Waveshare Cloud Control (https://www.waveshare.com/wiki/ESP32-S3-POE-ETH-8
DI-8RO-Waveshare Cloud)
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MicroPython Demo

01 RS485

Demo description

» This example implements the control of 8 relay switches via RS485 and 8Dl digital inputs

Code analysis

= relay control(): This function mainly executes the corresponding relay control operation
and outputs the corresponding status prompt information according to the array index
passed through the parameters
= Parameter analysis
= index:In the main function, the program will parse the received RS485 data and
match it with the preset control command array. When a match is found, the
relay_control function is called, and the index position of the matching
command in the array is passed via index parameter
= Logical flow
= Use the if else statement to perform different operations based on the value
of index:
= |n the case of index < 8, that s, for the cHi~cH6 commands, the
relays[index].value function is used to switch the level status of the
corresponding GPIO pin, and at the same time, the corresponding
relay_status array element is updated to record the change of the relay
status, and the corresponding on or off prompt information is output
according to the final state of the relay. Finally, the beep function is called
to control the buzzer.
= For the case of index = 8, i.e.,, for the ALL_OoN command, all GPIO pins
(corresponding to 8 channel relays) are set to high level (on state), and all
elements of the relay_status array are set to 1 through the for loop,
indicating that all relays are turned on. A message indicating that all relays
are turned on is then output. Finally, the beep function is called to control
the buzzer.
» For the case of index = 9, i.e, for the ALL_OFF command, all GPIO pins
(corresponding to 8 channel relays) will be set to low level (off state). Using
the for loop, all elements of the relay_status array will be set to 0,
indicating that all relays are off. A message indicating that all relays are off
will be output. Finally, the beep function will be called to control the
buzzer.
= |f the value of index does not match the above commands, the prompt
message of receiving non-command data will be output
= gpio_irq_handler(): The function controls relay switches through IO interrupts, with digital
interfaces DI1~DI8 corresponding to relays CH1~CH8. For example, when the digital
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interface DI1 is low, the relay CH1 is on, and when the digital interface DI1 is high, the
corresponding relay CH1 is off

RS485 Control

= Jump to RS485 Control Tutorial (https://www.waveshare.com/wiki/ESP32-S3-POE-ETH-8DI-
8R0O-RS485)

02 MQTT

Demo description

= This example implements network connection through an Ethernet interface and achieves
remote control of 8 relays via the MQTT communication protocol

Precautions

= Devices need to be created in Waveshare Cloud
= MQTT related parameters in the program need to be modified

Code analysis

= Function description
m ethernet_init() : Connect to the network via Ethernet port
® mqtt_connect() : Connect to MQTT server
= mqtt_subscribe() : Subscribe to MQTT topic
® mqtt_publish() : Publish MQTT message
» Parameter description
» MQTT parameters
m  MQTT_SERVER: Server IP
®  MQTT_PORT : Server port number
m MQTT_CLIENT_ID: Client ID
®  MQTT_USERNAME : Username
®  MQTT_PASSWORD : Password
= MQTT_SUBSCRIBE_TOPIC : Name of the subscribed topic
= MQTT_PuBLISH_TOPIC : Name of the published topic
= Logical flow
= Device Initialization: Initialize W5500 and MQTT, call ethernet_init(),
mqtt_connect() to connect to the network and MQTT server, and call
mqtt_subscribe() to subscribe to MQTT topics
= Control relay switch: Set the MQTT receive callback function through
client.set_callback() , wait for the MQTT message in the main loop, call
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mqtt_recv_callback() after judging the received MQTT message, parse the MQTT
message and control the corresponding relay switch

= Send relay status: In order to determine whether the relay switch operation is
successful from the server, the development board will call mqtt_publish() to send
the latest relay status to the server after controlling the relay switch

Waveshare Cloud Control

= Jump to Waveshare Cloud Control (https://www.waveshare.com/wiki/ESP32-S3-POE-ETH-8
DI-8RO-Waveshare Cloud)

External Expansions
RS485 Extended Relay Channels [Expand]

Resources

Su pporting Resources
Demo

» Onboard RGB LED Test Demo (https://files.waveshare.com/wiki/RP2350-ETH-8DI-8RO/RP2350
-ETH-8DI-8RO-RGB.zip)

m RP2350-ETH-8DI-8RO Demo (https://files.waveshare.com/wiki/RP2350-ETH-8DI-8RO/RP2350
-ETH-8DI-8RO.zip)

= RP2350-ETH-8DI-8RO External Expansion Demo (https://files.waveshare.com/wiki/RP2350-ET
H-8DI-8RO/RP2350-ETH-8DI-8RO-Expand.zip)

Datasheets
= W5500 Datasheet (https://files.waveshare.com/wiki/common/W5500 datasheet v1.0.2_1.pdf)
Official Resources

Raspberry Pi Official Documents

» Get Started with MicroPython on Raspberry Pi Pico (https://hackspace.raspberrypi.org/books/
micropython-pico)

= Raspberry Pi related books download (https://magpi.raspberrypi.org/books)

» Pico2 Schematic diagram (https://files.waveshare.com/wiki/common/Pico-2-schematic.pdf)

= Pico2 Pinout definition (https://files.waveshare.com/wiki/common/Pico-2-Pinout.pdf)

» Pico2 Getting Started (https://files.waveshare.com/wiki/common/Getting-started-with-pico-2.
pdf)
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= Pico2 C SDK User Manual (https://files.waveshare.com/wiki/common/Raspberry-pi-pico-2-c-s
dk.pdf)

= Pico2 Python SDK User Manual (https://files.waveshare.com/wiki/common/Raspberry-pi-pico
-2-python-sdk.pdf)

= Pico2 Datasheet (https://files.waveshare.com/wiki/common/Pico-2-datasheet.pdf)

= RP2350 Datasheet (https://files.waveshare.com/wiki/common/Rp2350-datasheet.pdf)

» RP2350 Hardware Design Reference Manual (https://files.waveshare.com/wiki/common/Hard
ware-design-with-rp2350.pdf)

Raspberry Pi Open Source Demos

m Raspberry Pi official C/C++ Demos (github) (https://github.com/raspberrypi/pico-examples/)
= Raspberry Pi official micropython Demos (github) (https://github.com/raspberrypi/pico-micro
python-examples)

Development Software

= Thonny Python IDE (Windows version V3.3.3) (https://files.waveshare.com/wiki/common/Tho
nny-3.3.3.zip)

= Pico environment building related software (https://drive.google.com/file/d/110wdNelJrX-Nh
CtEoGBAZgOCin9 VkGH3/view?usp=sharing)

m pico-vscode package (https://drive.google.com/file/d/18-KDNrQIIOKuTMdS6W5iblUGaGm3F
bVJ/view?usp=sharing)

= SSCOM (https://files.waveshare.com/wiki/RP2350-Relay-6CH/SSCOMS5.13.1_For_RP2350 Relay
_6CH.zip)

m USB-CAN-A TOOL (https://files.waveshare.com/wiki/common/USBCANV2.10.zip)

FAQ

Question: Raspberry Pi Pico 2 GPIO is configured as a pull-down input, why
does reading 10 show a high voltage level when the pin is left unconnected?

Answer:

You can refer to the RP2350-E9 section in the RP2350 Datasheet (https://files.waveshare.co
m/wiki/common/Rp2350-datasheet.pdf)

Question: When controlling other devices using RS485, it is not sensitive or
communication fails?

Answer:

https://www.waveshare.com/wiki/RP2350-ETH-8DI-8RO 36/37



10.05.26, 18:59 RP2350-ETH-8DI-8RO - Waveshare Wiki
Please move the jumper cap to 120R and try again. Some RS485 devices require a 120R

resistor to be connected in series

Support

Technical Support

If you need technical support or have any
feedback/review, please click the Submit

Submit Now (https://service.w

Now button to submit a ticket, Our support
team will check and reply to you within 1 to aveshare.com/)
2 working days. Please be patient as we

make every effort to help you to resolve the

issue.

Working Time: 9 AM - 6 PM GMT+8

(Monday to Friday)

Retrieved from "https.//www.waveshare.com/w/index.php?title=RP2350-ETH-8DI-8RO&oldid=110620
(https.//www.waveshare.com/w/index.php?title=RP2350-ETH-8DI-8RO&oldid=110620)"
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